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Chapter 1 – Introduction 
New technologies provide exciting opportunities for teachers to enhance student 
learning. Interactive computer software is one such technology and can be combined 
with interactive white boards to foster small and large group interaction. Such dynamic 
interaction provides opportunities for students to access mathematics in new ways and 
supports a greater range of learning styles. The dynamic interaction provides teachers 
with an additional component to their repertoire of instructional strategies. Interactivity 
engages learners and assists in supporting independent student investigations. Using 
Geometry Expressions (GX), for example, students can readily explore concepts, verify 
numerical solutions to geometry problems and explore properties of geometrical figures. 
Such activities support students search for patterns and construction of conjectures. 
These exercises correlate strongly with the process strands of common mathematics 
standards as well as the underpinnings of algebraic reasoning.   

I believe that students should be empowered as much as possible to take control of 
their own learning. It is through play that conceptual development is often the most 
rapid and long lasting. Vygotsky observed that children in play displayed intellectual 
development beyond what they showed in a school environment. (Kozulin 2007) 
Students engaged in inquiry and discovery activities may well be involved in intellectual 
play. A feature of the “play” environment is the capacity of the player to manipulate the 
objects and try things out. It is a safe environment in which to experiment.  A strong 
case can be made for intellectual play, a situation enhanced by the use of appropriate 
empowering technologies.   

Unfortunately many of our high school students have little opportunity to play, 
particularly in mathematics and particularly where the focus is on the ability to perform 
for the test. Many students see school as a drudgery to be waited out. Where this 
occurs it is sad and any way the spark of curiosity and then discovery can be reignited 
is a blessing. Interactive geometry programs are well known and powerful contributors 
to student learning. They provide a rich environment for exploration of geometric 
relationships. GX adds something new to the genre of interactive geometry as the 
construction process is more intuitive and potentially accessible to many more students.   

There are aspects of many interactive geometry programs that are difficult for the 
novice (student) user. For example creating a construction from scratch often requires a 
lot of geometrical knowledge which is beyond the student. To allow access to the 
benefits of Interactive geometry programs students are often presented with pre-
prepared sketches and students then play within the limited field these sketches 
provide. Pre-prepared sketches hide much of the intellectual work involved in creating 
the drawing in the first place. It seems as if the power of the software is just being 
tapped rather than unleashed. GX offers a potential pathway to loosen the leash. 

The activities in this book are based around GX. To draw upon a culinary metaphor, the 
book is intended to be a buffet with the teacher picking and choosing a menu that fits 
the whims and tastes of their class. The activities are wide ranging and touch much of 
the geometry and trigonometry taught in High School mathematics courses. The ability 
to solve trigonometry problems in an intuitive drawing / construction mode is exciting as 
it opens new ways of learning and teaching. When students are able to discover for 
themselves the ideas and relationships of geometry, learning outcomes particularly in 
terms of retention and understanding are much improved. Of course, there is no one 
approach that will work for all students. Some require more hand-holding particularly 
when working with a new and unfamiliar tool while others need only the briefest of 
exposures to see how the use of a new tool enables their learning.  
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With these experiences in mind, the activities in this book involve the use of GX in high 
school mathematics classes. The materials are designed to be flexible. They may be 
used as the basis for an independent geometry unit, as a set of labs for reinforcement 
or enrichment for a text based unit, as individual activities to be woven into the 
mathematics curriculum on appropriate occasions, as a support for differentiated 
instruction in the form of self-guided discovery and extension or as the basis for 
contextualized learning activities.  

 

Content and Organization  
Chapters 2 – 4 discuss key features of GX and the pedagogy underpinning the lab 
activities in chapters 5 to 10. GX is described as an interactive symbolic geometry 
program. Interactive geometry is a software genre with well known commercial 
packages, shareware programs and open source offerings. The features of this genre 
are documented elsewhere. These introductory chapters focus on Constraints (Chapter 
2) and Symbolics (Chapter 3), features that extend interactive geometry and a scenario 
(Chapter 4). The scenario is a passionate appeal for the use of an investigative 
approach with the teacher becoming more of a guide on the side.  

Chapters 5 – 10 are the lab activities. They are organized in themes which are likely to 
be covered in a number of high school mathematics courses. These themes are content 
based and develop from Middle school or beginning high school through to topics in 
advanced placement courses.  For example the chapter on trigonometry begins with the 
Pythagorean Theorem and extends through right triangle trigonometry, the sine 
formula, law of cosines and polar coordinates. The chapter on locus begins with the 
circle, and ends with Bezier curves. Each of these chapters is prefaced with an outline 
of the labs. Each lab has teacher notes to assist in planning.  

The themes and the chapters are: 

• Chapter 5 Congruence and Similarity  

• Chapter 6 Proof 

• Chapter 7 Transformations  

• Chapter 8 Trigonometry 

• Chapter 9 Coordinate Geometry 

• Chapter 10 Loci 

While the labs are self-contained, the development within each chapter assumes a 
growing knowledge of GX and ability to construct the drawings. Consequently initial 
labs have quite detailed instructions while later labs have less detail, assuming that 
students have prior experience with the drawing tools required. This is consistent with 
encouraging students to become increasingly independent and to use the software to 
support their own learning. Consequently some preliminary instruction may be required 
for advanced classes beginning with later activities within the chapters. Using 
interactive white boards has been found to be very effective in demonstrating the 
drawing tools in GX.  

The student manual (in press) provides a subset of the activities in this book associated 
with a particular course of study. 

The activities in each unit provide a framework for students’ explorations. Often there 
are one or two activities requiring very little technical expertise that you will feel 
comfortable giving your students with little or no guidance beforehand. Other activities 
maximize guided discovery by students. Some of these are more open-ended than 
others, and their difficulty levels vary. You should choose those activities that are most 
appropriate for the ability and skill levels of your students. The text provides blackline 
masters for student work.  
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Terminology: 

GX can be used with menu options or icons. The icons arranged in toolboxes duplicate 
most of the menu options. The icons are shown sometimes, often the first time a tool is 
used in the text and the menu item or description used thereafter. The menu item is 
referred to using the vertical bar to separate levels. For example 
Edit | Settings | Math | Math | Angle Mode means 

• choose the Edit menu,  

• choose Settings from the Edit menu,  

• choose the Math tab in the left sidebar  

• open  →   the Math window  

• choose Angle Mode from the Math window.  

Draw | Line Segment is the  icon from the Draw toolbox.  

 
 
The first time a particular construction or program feature is used a detailed description 
is given. A statement of the construction is made and then the steps detailed in point 
form. Where the feature is used subsequently the point form detail is not provided. 

For example in an early Lab:  

Construct a line segment of length 4.  

From the Draw menu select the Line Segment tool .  
Click, drag and release is one way to draw the line segment. 

Choose the Select tool . 
Click on the line segment. 

Click the Constrain Distance/Length tool  
Type in 4 and press Enter.  

Subsequently the Activity might just say 
Construct a side of length 4.  
 

Hints and suggestions  
If you’re new to GX, work the activity yourself in your preparation for working with 
students. Becoming familiar with the activity can greatly facilitate your own learning of 
the software and increase your comfort level with these materials in the classroom. 
GX’s online help is useful for clarifying the use of a menu or tool and in understanding 
GX specific language. 

Even if you’re using GX for the first time, don’t let your inexperience keep you from 
placing the software into the hands of your students! One of the best aspects of using 
interactive geometry software is learning along with the students. Invariably when I 
have had a problem in class it is one of the students who is able to find a solution, 
teaching me and the rest of the class. Such experiences are valuable in modeling 
approaches to learning, moving the dynamics of the classroom to a more collaborative 
learning environment and valuing the skills students bring to the classroom. Nothing in 
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the classroom can compare to the excitement generated when students and teacher 
experience the joy of learning mathematics together.  

Where an activity has an extension component, there is an opportunity for more open 
investigation. For the able students this is where the most valuable learning can be 
gained.   

Regardless of the degree of structure you are comfortable with, be sure to allow time for 
students to simply explore with the software. Before or after initial activities students 
enjoy trying the tools and experimenting on their own. This free exploration motivates 
students to want to learn more about the capabilities of the software and invariably 
leads to mathematical discovery or consolidation. Where a student holds a geometrical 
misconception this experimentation can provide the crucial discord required for the 
student to re-conceptualize and thus move forward with their learning in mathematics. 

I encourage you to allow your students to work in pairs or in small groups for some if 
not most of the activities. The units in this book, as well as GX itself, are ideal 
instruments for cooperative learning. When we teach this way, our students exhibit both 
increased mathematical understanding and greater proficiency in using the software.  
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Chapter 2 – Constraints 
Constraints is a feature distinguishing GX from other dynamic geometry programs. This 
chapter briefly describes attributes in drawings that can be constrained, an application 
using Constraints as a pedagogical approach compared to other interactive geometry 
programs, the use of Constraints to solve a problem and to develop understanding of a 
problem. These examples indicate reasons why Constraints have application in high 
school mathematics courses.   
 
Think of Constraints as a measurement that we fix in our drawing. For example, when 
drawing or constructing a figure on paper using drawing instruments we draw lines of 
particular lengths (using ruler and compass) and create angles of particular measure 
(using a protractor or template). Constraints mirror this process in an electronic 
construction. We can draw a line and then set its length or select intersecting lines and 
set the angle. There are many more attributes that can be constrained, 
 
In addition GX allows the user to constrain 
attributes such as coordinates of points, 
perpendicularity, parallel, direction or slope of 
lines, vectors, circles, coincidence, tangency, 
congruence, equation and point proportional. 
The toolbox to the right illustrates the range of 
properties that can be constrained. 

 

 
Using Constraints is closely aligned with traditional construction techniques. 
Consequently I find students are more able to create drawings independently of the 
teacher than with other dynamic geometry software. The following example involves 
exploring the converse to the Pythagorean Theorem and compares the use of a non-
constraint based interactive geometry system with the use of Constraints. 
 
Explore the converse of the Pythagorean Theorem: 

How do we know whether or not a triangle has a right angle given the lengths of each 
side? A teacher might begin by posing the question, “Is a triangle of sides 5, 6 and 7 
right angled?” Clearly drawing an accurate sketch will give the student a feeling for 
whether or not this is the case with a follow up using the theorem.  
 
To draw a sketch using dynamic geometry software 
I would ask the students to  

• draw a triangle, 

• measure the lengths  

• drag vertices until they get a triangle close to 
the desired measurements.  

The diagram on the right shows such a sketch. 

The sketch can be used to explore other side 
lengths by dragging the vertices to change the side 
lengths. 

C

B

A ⇒ ∼6.089

⇒ ∼6.932 ⇒ ∼5.033

 
 
Note that the side lengths will not fit the original problem specifications exactly but it is 
close enough to be convincing that there is no right angle in a 5 – 6 – 7 triangle. 
Dynamic Geometry software enables this exploration to be done readily and intuitively 
by students. 
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LAB # 1   Three sides 

 

Aim:  Investigate whether or not knowing the lengths of three sides is sufficient to 
ensure that the factory will construct the window to fit. 

 

 
 

Alpine Glass specializes in those difficult to make windows. 
 
Aspen Lodge has asked for their premium double glazed panels for their unique 
architect designed ski lodge. The triangular windows need to be measured up by 
Cherie, Glacier Glass’ local representative. The measurements will be sent back to the 
factory for the custom double glazed panels to be manufactured. 

Cherie, Glacier Glass’ local representative, measures the three sides. She measures 4, 
6 and 8 feet.  

Part 1 

Open Geometry Expressions and start a new sketch File | Open. 
 
Construct a side of length 4.  

From the Tools panel select the Draw | Line 

Segment tool .  
Click, drag and release is one way to draw the 
line segment. 

Choose the select tool . 
Click on the line segment. 

Click the Constrain | Distance/Length tool  
Type in 4 and press Enter. 
 
 
 

BA

4

 
The line segment has endpoints 
labeled A and B and is of length 4 
units. 

Draw a circle with center A and radius 6. 
From the Draw toolbox select the Circle tool 

. 
Click on A, drag and release. 
Select tool 
Click on A and then Ctrl-click on C 

Click the Constrain | Distance/Length tool  
Type in 6. 

C

BA

6

4
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Draw a circle center B and radius 8.  
 

 

E
C

BA

6

4

8

 
Mark points 6 units from A and 8 units from B.  

These are the points of intersection of the 
circles. 
 
Select both circles by clicking on one and then 
holding the shift key down click on the other. 
From the Construct menu select the 

intersection tool .  
 
It is also possible to choose the point tool and 
when the mouse is in the right spot both circles 
are selected and clicking will mark the 
intersection. 

C

E

A

F

B

D

8
6

  

Draw line segments AE and BE 

B

E

D

C

A 4

68

Hide the construction circles  
Select tool 
Click on circle 
Right click and choose Hide  
or View | Hide 

B

E
D

C

A 4

68

 
Check that the angle mode is set to degrees, 
the default setting is radians.  
 
Set the angle mode to degrees  

Choose Edit | Settings | Math.  
Click the down arrow by Angle Mode to select 
degrees.  

 

 

 
 

 
Measure the lengths and angles 

Select a side  
Choose Calculate (Output)  |Real | Length 

AB = 4 

AE = ____ 
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Repeat for each side. 
Select two sides (Ctrl-click) 

Choose Calculate (Output) | Real | Angle  
Repeat to measure the angles 

BE = ____ 

∠A = _______° 

∠B = _______° 

∠E = _______° 

Drag the vertices of your triangle. Describe what happens. (Think about what changes 
and what stays the same.) 

 ______________________________________________________________________  

 ______________________________________________________________________  

Part 2 

Open a new sketch 
 
Construct a triangle. 
Constrain the lengths to 4, 6 and 8. 
Measure the angles. 
 

∠A = _______° 

∠B = _______° 

∠C = _______° 

How do the angles compare to your triangle in Part 1? ___________________________  

Congruent figures have the same size and shape. 

Are the triangles in each sketch congruent?  ___________________________________  

Part 3 

Build a triangle with sides 5, 12 and 13 units. 
Change the lengths on your current sketch.  
(Double click on the measurement, and then enter the new value). 

What kind of triangle is this?  _______________________________________________  

Part 4 

What happens when you try with sides 4, 5 and 10?  ____________________________  

Why? _________________________________________________________________  

 ______________________________________________________________________  

(Note: Press Ctrl-Z to undo the previous step) 

If Cherie sends the lengths of the three sides will the manufactured window fit? 

 ______________________________________________________________________  
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LAB #1  Three sides 

In this activity students: 

• Simulate a scale drawing using ruler and compass construction; 

• Establish that specifying the three sides ensures the correct window is 
manufactured (that all constructed triangles are congruent); 

• Construct the triangle using Constraints and 

• Investigate the triangle inequality. 

You may like to introduce the context of Glacier glass through a class discussion before 
beginning the lab activity.  

I.e. Cherie, Glacier Glass’ local representative, measures the three sides of the 
triangular window as 4, 6 and 8 feet. Assuming that Cherie’s measurements are 
accurate and the factory creates a triangular window panel with these 
measurements accurately, must the window fit? It may be useful to note that in 
practice the glass would be cut smaller allowing a tolerance for fitting. This would 
normally be about three eights of an inch. 

The instructions for the GX construction are quite detailed so it can also be used as an 
introduction to drawing in GX. This includes setting the angle mode to degrees as GX’s 
default mode is radians. For a class that has significant experience of GX you may like 
to develop a condensed activity sheet with outline instructions only.  

A simpler way of creating the 4-6-8 triangle would be to draw the triangle and then 
constrain the sides. However, students would not have the opportunity to explore why 
knowing the three sides means that only one triangle can be created.  

A further discussion point needing to be addressed is mirror images. It is likely that 
some students will create mirror images and see these as different triangles as it is not 
possible to superimpose one upon the other. Flipping the window over will allow it to fit. 
Having two 4”, 6” and 8” cardboard triangles already prepared would be helpful. Draw 
around the model on the board. Ask a student to measure the “window” and record the 
measurements. Simulate the mirror image being unloaded on site with the other model 
and then ask for it to be installed.  

Solution 

Part 1 

AE = 6 
BE = 8 

∠A = 104.5° 

∠B = 46.6° 

∠E = 29° 
The size and shape stay the same, the 
orientation and position can change. 

Part 2 

∠A = 104.5° 

∠B = 46.6° 

∠C = 29° 
The angles are the same. 
The triangles are congruent. 

Part 3 

Right triangle 

Part 4 

It disappears into a line of length 10. 

This is because you can not have a 
triangle where one side is longer than 
the sum of the other two sides. This is 
called the triangle inequality. 

If Cherie sends the lengths of the three 
sides the manufactured window will fit? 


